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Chapter 8: A Study of Decision Making 

 If you understand the material in Chapters 2-6, then you understand all of the 

computer techniques that were involved in the studies of Birnbaum (in press-a; 1999b).  

If you have not done so already, load and run the decision making experiment on your 

CD, Ch8_exp1.htm.  This chapter will review background in the psychology of decision 

making that will help you understand that study.  You will also practice some tricks of 

data processing and analysis, and you will learn how to apply them to analyze the 

decision making experiment. 

A. Psychology of Decision Making 

 Why do people do what they do?  Psychology is the science of behavior, so it 

attempts to answer this question.  As a science, it is the study of rival theories, or 

explanations, of behavior.  One approach to understanding human behavior is to interpret 

what people do as the result of a decision to act.   Normative decision theory prescribes 

how a rational person should decide and descriptive decision theory is the empirical study 

of how people do make decisions.  As you will see, people do not always do what 

theoreticians think they should do. 

 Consider the decision of whether or not to carry an umbrella tomorrow.  The 

contingencies are described in the matrix below: 

 Rains Does not Rain 

Carry umbrella Stay dry Extra work 

Don't carry umbrella Get wet Travel light 
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 Clearly, if it is going to rain, then it would be better to carry your umbrella 

tomorrow, because you will stay dry.  However, if it were not going to rain, then it would 

be easier to leave the umbrella at home.  The greater the probability of rain, the stronger 

the argument to carry the umbrella.  If the weatherman says that there is a 50% chance of 

rain in the afternoon, would you carry your umbrella?  What you decide to do would 

depend on your subjective values for staying dry, getting wet, for carrying an umbrella 

when it does not rain, and for traveling light.  What you decide to do also depends on 

your beliefs concerning what will likely happen when the weatherman says, “the chance 

of rain is 50%.” 

 Consider the following choice, designed to create situations simpler than that of 

deciding to carry an umbrella.  In this case, a fair coin will be tossed, and the 

consequences will be monetary payoffs that depend on the outcome of the coin toss. If 

you choose Alternative A, then if Heads occurs, you win $100 and if Tails occurs, you 

lose $10.  However, if you choose B, then if Heads occurs, you lose $100, and if Tails 

occurs, you win $10. This choice seems simpler than the umbrella decision, because the 

probabilities of Heads and Tails are better defined than the likelihood (and strength) of 

rain when the weatherman says “50%.” It also seems simpler because the consequences 

are money, rather than subjective feelings such as those of getting your hair wet.  In this 

choice, most people would probably choose A over B. 

 Heads Tails 

Alternative A $50 –$10 

Alternative B –$100 $100 
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 Now consider the following choice, which produces more disagreement. 

 Heads Tails 

C $40 $40 

D $100 $0 

 

In Choice C, you win $40 whether Heads or Tails occurs, so it is a sure $40.  For D, 

however, you might win $100 or $0. Some people prefer C and others will prefer D. 

B. Expected Value and Expected Utility 

The expected value (EV) of a gamble can be thought of as the average amount 

that you would win if the gamble were played an infinite number of times.  The EV is 

given by the following formula, 

   EV(G)  pi xi
i1

n

       (8.1) 

where EV(G) is the expected value of gamble G, pi and xi are the probability and 

monetary value of consequence i, summed over all n mutually exclusive and exhaustive 

outcomes of the gamble.  For D, EV(D) = $50, because the two outcomes (Heads and 

Tails) have probabilities of .5, and the consequences are $0 and $100, so EV(D) = .5($0) 

+ .5($100) = $50.  The EV of C is $40.   

In terms of expected value, gamble D is better than C; however, many people 

prefer C, because it provides a "safe and sure" $40, whereas gamble D seems more 

“risky.”  When people make choices like this—i.e., they prefer a sure thing to a gamble 

with the same or even higher EV—their behavior is described as "risk averse." 

 Risk aversion is inconsistent with the theory that people choose gambles by their 

EV; however, Bernoulli realized that risk aversion is consistent the theory that the 
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psychological value of money is a nonlinear function of money.  This theory of Expected 

utility (EU) can be written as follows: 

   EU(G)  piu(xi )
i 1

n

       (8.2) 

where u(x) is the utility, or psychological value, of a certain amount of money.  

Bernoulli proposed Equation 8.2 as an explanation for the St. Petersburg paradox 

(see Chapter 5) and other violations of EV.  If the utility of money is a nonlinear function 

of its cash value, then the cash value of the Expected utility of the St. Petersburg gamble 

can be finite.  Bernoulli discussed the functions, xxu log)(  , and xxu )( as possible 

utility functions that would explain the St. Petersburg paradox and would also explain 

risk aversion, such as a preference for choice C over Choice D.   

Suppose xxu )( .  For gamble D, the EU is 1005.05.   = 5.  For gamble C, 

EU(C)  = 405.405.   = 6.32 > EU(D) = 5; therefore, this theory predicts that a person 

would prefer C to D.  In EU theory, C is better than D because the psychological value of 

$40 is better than half the psychological value of $100.  In other words, this theory says 

that the subjective difference from $0 to $40 exceeds the subjective difference from $40 

to $100. 

C. The Principle of Dominance 

 Some choices are relatively easy, and there is little disagreement, as in the choice 

between E and F:
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 Heads Tails 

E $100 $50 

F $65 $50 

 

Notice that gamble E is strictly better than gamble F, because for either Heads or Tails, 

the consequence of choosing E is always better than or equal to the consequence of F--

For Tails, the consequences are the same, but for Heads, E gives $100 and F gives only 

$65.  When one gamble is strictly better than another in this way, we say that E 

dominates F.  If G and H are two distinct gambles such that xP(  > t G) xP( > t  H), 

then gamble G is said to stochastically dominate gamble H.   This concept is also known 

as “first stochastic dominance.” 

 Many descriptive (psychological) theories of decision-making, including 

Expected Utility theory, imply that people should obey stochastic dominance.  These 

theories predict that people will choose the dominant gamble.  The study described in this 

chapter tested conditions under which people satisfy and violate dominance.  This study 

also tested other properties of choice (Birnbaum, 1999b).  

D. Decision Making Experiment  

 If you examine Ch8_exp1.htm in a text editor, you will find that the experiment 

makes use of hidden variables, text boxes, and radio buttons. There is no new computer 

technique here, just variations of things you have learned in previous chapters.  Note that 

each choice between two gambles is constructed from a set of three radio buttons.  By 

using three radio buttons, it is possible to distinguish preference for the first gamble (-1), 
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preference for the second gamble (+1), or a failure to respond (0).  Note that the button 

for non-response is in the left margin, making it easy for the subject to see if she or he has 

completed all of the questions.  A portion of the experiment is shown in Figure 8.1.  

 Insert Figure 8.1 about here.   
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Figure 8.1. Appearance of two trials in the decision-making experiment, Ch8_exp1.htm. 
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 When this experiment was actually run, some lucky participants were given a 

chance to play one of their chosen gambles for real.  For the first 1900 people tested, 

there were 19 winners, including 11 who won over $90.  The version on your CD does 

not offer prizes, but you can get an idea of what it was like to be a participant in the 

study.   

 One of the questions addressed in this study is as follows: Would people, 

motivated by money, choose the dominant gamble?  It is not only the rational thing to do, 

but it is also predicted to be what people would do if they satisfied Expected Utility 

theory or one of several modern utility theories (Luce & Fishburn, 1991; 1995; Tversky 

& Kahneman, 1992).   However, configural weight models of Birnbaum (1997) imply 

that people will violate stochastic dominance in certain specially constructed choices. 

E. Rank-Dependent Expected Utility Theory 

 The theories of Luce and Fishburn (1991; 1995) and of Tversky and Kahneman 

(1992) have the same representation as Rank-Dependent Expected Utility theory 

(Quiggin, 1993) when the gambles have strictly positive consequences.  These theories 

represent the utility of such gambles as follows: 





n

i
iii PWPWxuGRDU

1
1 )]()()[()(    (8.3) 

where RDU(G) is the rank-dependent expected utility of gamble G; u(x) is the utility of 

consequence x; W(P) is a strictly monotonic weighting function that assigns decumulative 

weight to decumulative probability, with W(0) = 0 and W(1) = 1; iP  is the (decumulative) 

probability of winning ix or more and 1iP  is the probability of winning strictly more than 

ix .  If W(P) = P, then this theory reduces to EU theory.  This theory can account for the 
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Allais paradoxes, phenomena that violate EU theory (Quiggin, 1993).  This theory also 

implies that if G stochastically dominates H, then the RDU(G) > RDU(H), so people 

should choose G over H. 

F. Comparing Rival Theories 

Use Netscape to load the decision calculator, taxcalculator.htm, from the CD.  

This calculator uses JavaScript  (presented in Chapters 17-19) to calculate predictions for 

three models of decision-making.   This calculator is also available at URL 

[http://psych.fullerton.edu/mbirnbaum/taxcalculator.htm]. 

One model is the TAX model of Birnbaum and Navarrete (1998), the second is 

the Cumulative Prospect Theory (CPT) model of Tversky and Kahneman (1992), and the 

third is EV.  The CPT model is a special case of Equation 8.3.  Calculate the value of 

gambles I and J in Choice 5 of Figure 8.1.   

To use the calculator, first press the Set Values button.  This action sets the 

parameters of the models to values published in the literature.  Next, type 3 for the 

number of outcomes.  Type the outcomes (the prizes) in order from the lowest outcome 

on the left to the highest.  Leave spaces to the right blank.  Enter the corresponding 

probabilities in the spaces provided.  Press the Compute button and read off the values 

according to the CWT (configural weight, TAX model), CPT, and Expected Value.   

Help and instructions are available in the file. 

You will see that different theories make different predictions for this choice.  

Which gamble has the higher EV?  (Answer: I is higher in EV than J, $87.7 to $87.3). 

Which gamble has the higher CPT value? (Answer:  I is higher than J, $72.27 to $71.73). 

Which gamble has the higher TAX value? (Answer: J is higher than I, $63.10 to $45.77).  
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Which gamble did you pick?  If you are like most undergraduates who served in this 

experiment, you probably chose J, as predicted by the TAX model.  In the next sections, 

you will analyze the data to find out which gamble most people preferred to see whether 

the CWT TAX model or CPT is more accurate. 

G. Data Analysis of Decision Experiment 

 In the next sections, you will import the data file into Excel to analyze the data.  

You could also use SPSS, as in Chapter 6.  

Your CD includes files named clean.csv and clean.xls that contain the data analyzed 

in this chapter.  These files have been cleaned of identifying information such as email 

addresses that were used to notify winners.  To follow along in this analysis, open the file 

clean.xls in Excel—either the one you created in Chapter 6, or the one provided on the 

CD.   

Insert Figure 8.2 about here. 
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Figure 8.2.  Appearance of clean.csv when opened by Excel. 
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The variable names have been entered already in clean.csv.  If you examine the 

experimental form, Ch8_exp1.htm, you will see that the date and time are inserted as 

hidden variables.  Note that the time variable shows up as ######## in Figure 8.2.  The 

times are too big to fit in the default display.   

You can adjust the spacing of the columns in Excel by placing your arrow pointer 

on the cracks between column labels at the top of the sheet, clicking and dragging.  Place 

the mouse pointer on the crack between C and D, at the top of the column.  When the 

two-headed arrow appears, drag the crack to the right to make column C bigger.  You can 

also double-click on the crack to automatically adjust its width to the data.  Now the 

times can be read.  Next, respace the columns for the choices ( –1 and 1), to make them 

thinner so that you can see more of the data on one screen.   

Before you go on, save the file as an Excel workbook, but so as not to erase the 

work of Chapters 6 and 7, save it this time on your hard drive as clean2.xls.  

Check the variable names in the first row.  These names have been entered for 

you, but in a new study, you would fill them in according to what is in the new 

experiment.  The first variable identifies the experiment, “exp,” the next two variables are 

date and time, followed by country (nationality), age, sex (gender), and edu (education).  

After that, the next 20 variables (v1 to v20) are the choices in the 20 decision problems, 

in the order that they appeared in Ch8_exp1.htm.   The next item is a question that asked 

if the participant has read a scientific paper or book on the theory of decision making, 

which is called Read DM (read on decision making).  The last value is a field for 

Comments. There had also been a box for the email address, which has been removed. 

Some of the subjects were students who were tested in the department’s computer lab, 
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and others were volunteers who took the experiment via the Internet. Select the first row, 

and click B icon on the formatting toolbar to make the variable names bold. 

H. Filtering the Data 

Filter the data so that all records have “Ch8_exp1” in the first column. As in 

Chapter 6, select Filter: AutoFilters from the Data menu. A number of little pull down 

arrows will appear on the variable names.  In the first column, select Ch8_exp1.  The file 

will then appear as in Figure 8.3. 

 Insert Fig. 8.3 about here 

 Selecting one value causes all other lines of data to be hidden from view.  Now 

select all of the data showing—do this by clicking in cell A1 and dragging the mouse to 

the right to column AC and down the page until everything visible is selected (to row 

1288).  Next, choose Copy from the Edit menu and then select from the Insert Menu, 

Insert a new Worksheet.  Paste the selected data into the new worksheet, and you have 

filtered the data needed.  This time, you were instructed to copy the first row because the 

variable names are correct for this study.  It is a good idea to save the file again.  The file 

now appears as in Figure 8.4.  (Your CD also contains the file, DMaking.xls, with which 

you can compare your results, and DMaking.csv; which you can load into SPSS without 

the filtering step.) 

Insert Figure 8.4 about here.
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Figure 8.3.  From the Data menu, select Filter, then Autofilters.  Drop down filter arrows 

appear.  The arrow in the first column has been clicked, showing a list of possible values 

in the first column.  Select Ch8_exp1. 
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Figure 8.4. Appearance of the file after the data have been filtered, copied, and pasted 

into a new, inserted worksheet. 
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Notice that the original data are still on the worksheet called “clean” (see the tabs 

at the bottom of the worksheet).  Clicking on a tab will show the data on that sheet.  By 

double-clicking on the Sheet1 tab, you can rename it Ch8_exp1.   

I. A Pivot Table Report for Decision Making 

 To address the original questions of the research, you will create cross tabulations 

using the Pivot Table Report.   To illustrate, consider Choices 5 and 11 of the experiment.  

These choices are as follows: 

5. Which do you choose? 

 I: .05 probability to win $12  J:  .10 probability to win $12 

.05 probability to win $14   .05 probability to win $90 

.90 probability to win $96   .85 probability to win $96 

11. Which do you choose? 

U:  .05 probability to win $12  V: .05 probability to win $12 

     .05 probability to win $14   .05 probability to win $12 

.05 probability to win $96   .05 probability to win $90 

.85 probability to win $96   .85 probability to win $96 

The responses were coded so that preference for the first gamble (shown here on the left) 

was coded as a –1, and choice of the second gamble was coded as  + 1. 

Note that gamble I is the same as U and that J is the same as V, except that 

identical consequences in U and V have been combined in Choice 5 by adding their 

probabilities.  Many decision theories, including the Rank-Dependent Utility theory of 

Equation 8.3, imply that people will choose I over J and U over V because I dominates J 

and U dominates V.  However, according to the configural weight TAX model, with 

parameters of Birnbaum (1999a), people might choose U over V, and yet choose J over I.  

In Section F, you used Netscape to load taxcalculator.htm, and you found that the TAX 



Chapter 8 3/28/16 17 

model, unlike CPT and EV, predicts that J has a higher value than I.  You can enter the 

four outcome gambles of U and V to check that the TAX model also predicts that people 

will choose U over V.  

 The accuracy of this prediction can be examined in a Pivot Table Report of the 

data.  First, click the mouse in A1.  Then, from the Data menu, select Pivot Table Report. 

A series of “Wizard”  dialogs appear, which are shown in Figures 8.5—8.9.  The 

procedure is similar to that described in Chapter 6. 

 Insert Figure 8.5—8.9 about here. 
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Figure 8.5. Pivot Table Wizard, Step 1. Choose Microsoft Excel list or data base, then 

click Next. 

 

 

Figure 8.6. A range box appears; the program may correctly anticipate the range. If 

not, enter the range of cells, including all of the data, or click in the box, and use the 

mouse pointer to select the range in the worksheet.  Click Next. 
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Figure 8.7. In Step 3 of the Pivot Table Wizard, drag sex from the right to the PAGE box, 

drag V5 to the ROW, drag V11 to the COLUMN, and drag V5 again to the DATA field.  

If ”Sum of V5” is showing or another function besides “Count of V5,” then double click 

on it, which will bring up the dialog of Figure 8.8.  

 

 

Figure 8.8.  Select Count from the menu and click OK.  Then drag edu (education) to the 

PAGE box in Figure 8.7, and click Next. 
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Figure 8.9.  Select New worksheet, and click Finish. 

 

 

Figure 8.10. The Pivot Table for V5 and V11 of the decision making experiment. 
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After the pivot table has been constructed, you can drag a variable from the ROW 

to COLUMN.  You can drag it away, which will eliminate it from the table. Note that the 

“PAGE” variables, sex, and education, list “all” indicating that both sexes are included 

and all education levels.  To see the results for just females, for example, click on the 

down arrow, and select F.  The table then displays the results for only females.  You can 

do the same to examine the results for just males, or for different levels of education. You 

can also select Pivot Table Report again and create another table. 

 The table shows that of the 78 subjects, 54 chose J over I on Choice 5, 

representing 70% violations of stochastic dominance on this choice!  These results are 

similar to those reported by Birnbaum and Navarrete (1998) who tested undergraduates in 

a much longer study.  However, on Choice 11, 64 chose U over V; in other words, 82% 

satisfied stochastic dominance, (only 18% violated stochastic dominance).  To ask if the 

rate of 70% is significantly different from 18%, one can use the test of correlated 

proportions.   

J. Statistical Test of Correlated Proportions 

This test is a binomial sign test that compares the number who violated 

dominance on Choice 5 and satisfied it on Choice 11 (49) against the number who had 

the opposite reversal of preferences (8).  The binomial sign test then asks the question, 

what is the probability of getting this split (49 to 8) if these n =  57 who switched 

preferences were equally likely to have switched in either direction?  In other words, this 

equals the probability of tossing 57 coins and finding 49 or more are “Heads.”  The 

binomial distribution has a mean,  = np, where n is the number of independent trials and 

p is the probability (in this case, p = ½  so  = (57)( ½ ) = 28.5, and it has a standard 
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deviation,  )1( pnp  n this case,  = )5)(.5(.57  = 3.77.   For small n, (n < 30), 

one can look up the cumulative probabilities in a binomial table.  As n gets large, the 

binomial can be approximated by the normal distribution, so 




X

z  can be compared 

to the standard normal distribution, in which the probability is .95 that z will fall between 

–1.96 and 1.96.  For this case, z = 5.43 [z = (49 –28.5)/3.77]; because such an extreme 

value of z is extremely unlikely by chance, one can reject the null hypothesis that these 

two types of violation of stochastic dominance are equally probable.  Instead, the data 

show that significantly more people violated stochastic dominance on Choice 5 than on 

Choice 11. 

 What is going on here?  The configural weight, TAX model assumes that people 

average the values of the information with weights that are affected by the probabilities 

and the ranks of the payoffs.  Lower-valued consequences take weight (attention) from 

higher valued consequences.  Because J has two good outcomes ($90 and $96) whereas I 

only has one good outcome ($96), this configurally weighted average gives J a higher 

value than I.  However, when the outcomes are split in Choice 11, corresponding 

outcomes receive the same weight, so higher consequences produce higher averages. The 

TAX model satisfies dominance for Choice 11 even though it violates it in Choice 5. 

 Another way of looking at the results is to consider them evidence of event-

splitting effects, which are violations of coalescing.  Rank-dependent models imply that 

people should make the same choice in either Choice 5 or Choice 11, since the only 

difference is in how the events are split or coalesced.  The data show significant 

violations of coalescing, which according to the configural weight model, are the cause of 

violations of stochastic dominance (Birnbaum & Navarrete, 1998).  
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Expected value, expected utility, and rank dependent expected utility theory 

(including cumulative prospect theory) all predict that people should make the the same 

decisions in Choices 5 and 11.  These theories imply that people should prefer the 

dominant gamble in both choices.  However, the configural weight, TAX model predicts 

that people will violate stochastic dominance in Choice 5, and that they will satisfy 

stochastic dominance in Choice 11.  These results thus refute the descriptive accuracy of 

a class of theories of decision making, but the configural weight, TAX model remains a 

viable descriptive theory. 

Birnbaum (in press-a; 1999b) reported Web studies involving over 1900 people in 

which systematic violations of stochastic dominance were observed; these studies yielded 

similar conclusions to those obtained from the sample of data included on your CD.  

Those studies also compared the results of highly educated people with those of college 

students tested in the lab.  Data from the Internet were better educated and less likely to 

violate stochastic dominance than those from the lab, but both studies reached the same 

conclusions regarding the viability of the theories compared.  Because the Web sample 

was so large and diverse, it was possible to separate the data for analysis within genders 

and education levels.  It was found that violations of stochastic dominance were 

correlated with education: better educated people are less likely to violate stochastic 

dominance. 

K. Summary 

 This chapter reviewed Expected Value, Expected Utility, and Rank-Dependent 

Expected Utility theories.  These theories imply that decision makers should satisfy 

stochastic dominance.  Procedures for conducting an experiment on decision making via 
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the Web and for analyzing the data were described, and the materials used in the 

experiment were included on the CD. An on-line calculator that can be used to calculate 

the predicted values of gambles from three theories was described.   Data included on 

your CD were analyzed to show that people violate stochastic dominance on certain 

choices where people are predicted to violate stochastic dominance by the configural 

weight, TAX model of Birnbaum and Navarrete (1998).  

L. Exercises 

1. Construct pivot table reports for other combinations of choices in the decision making 

experiment.  For example, Choices 7 and 13 are like those of Choices 5 and 11, 

except the position of the dominant gambles has been reversed to counterbalance 

position in the choice.  Do Choices 7 and 13 yield the same conclusions as Choices 5 

and 11?   

2. When you have your own scripts, you can use different scripts for different 

experiments, in which case you will not need to separate data by filtering.  But even 

when a separate script is used for each experiment, filtering can be very useful for 

studying the data.  For example, look at Choices 3 and 4 of the decision experiment.  

If a person violated transparent dominance on these choices, maybe that  person did 

not understand the instructions.  To check how the results would be changed by 

filtering on Choices 3 and 4, you could for example filter v3 for –1 and v4 for +1.  

How many people violated dominance on both Choice 3 and 4?   

3. Create a Pivot Table of v5 and v7.  Look closely at the HTML, and you will see that 

choosing J in Choice 5 (+1) is a violation of stochastic dominance, and choosing M 

over N (–1) is a violation of stochastic dominance in Choice 7.  From your Pivot 
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Table of Choices v5 and v7, find out if significantly more people have two violations 

(+1 and –1 on v5 and v7) than have no violations on those two trials (–1 and +1 on V5 

and V7).  The appropriate statistic in this case is the binomial test of correlated 

proportions.  In this case, the statistic tests the proposition that the proportion of 

violations is .5; if significantly more people have two violations than have zero, it 

means that the overall probability of violations, averaged over V5 and V7,  exceeds 

½. 

4. Analyze the data by SPSS, using crosstabs.  You can import Dmaking.csv to SPSS. 

5. Project idea: Can you think of some type of training that will cause people to have 

fewer violations of stochastic dominance?  Design a between-subjects experiment in 

which different groups get different training.  Then have both groups complete the 

experiment.  See if the rate of violations is lower in the group with special training. 

6. Project idea: Read Birnbaum (in press-a; in press-d), and try to devise new choices 

that will distinguish CPT from the configural weight TAX model.  Before you run 

your experiment, use the calculator to make sure that at least two theories make 

different predictions. 

 


